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SCHEME OF WORK 

DATA PROCESSING 

Information & Communication Technology Sept 8 – November 

WEEK TOPIC SUB-TOPICS 

1 REVISIONS  

2 Computer Virus                      -Definition, Types and Sources 

3 Computer Network - Definition, Elements, Types 

   

4 Data Model 
- Definition 

- Concepts of data models 

5   

6 Date Model  

7 Continuous assessment/Mid Term Break  

8 Data Model  

9   

10 Data Model  

11 Data Model  

12 Examination   

13   

WEEK TOPIC SUB-TOPICS 
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1.  REVISION 

Objective: By the end of this class, a student should be able to recall last term’s work 
Duration: 40mins 
Week: 1 
Teaching Method/Strategy: Method 
Entry Behaviour (How you plan to start your Class):  Interaction 
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2. DATA MODEL I 

Objective: By the end of this class, a student should be able to state the practical uses of the internet 
Duration: 40mins 
Week: 2 
Teaching Method/Strategy: Method 
Entry Behaviour (How you plan to start your Class): Class Discussion 
 
Data Modelling is the process of structuring and organizing data.  

 

A database management system (DBMS) is a software system for creating and managing databases. A DBMS 

enables end users to create, protect, read, update and delete data in a database. 

 
Concept of Data Modelling  

Data modelling techniques and tools help to capture and translate complex system designs into easily understood 

representation of data flows and processes, creating a blueprint for construction and re-engineering.  

Data Models provide a structure for data used within information system by providing specific definition and format.  

Data Model shows the dataflow and logical interrelationship among different data elements.  

Compatibility of data can be achieved, if a data model is consistently used across the systems.  

 
Data Model definition 2: A data Model also describes how to organized data using a database management system. 

 
Approach in Data Modelling  

There are different approaches to data modelling, including;  

 

Conceptual Data Modelling: The conceptual data modelling identifies the highest-level relationships between different 

entities. This is the first step in organising the data requirements.  

 

Logical Data Modelling: The logical Data modelling illustrates the specific entities, attribute and relationships involves 

in a business function. It serves as the basis for the creation of the physical data model.  

 

Physical Data Modelling: The physical Data Modelling represents an application and database-specific implication of a 

logical data model and describes the physical means used to store data.  
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3.     DATA MODEL II 

Objective: By the end of this class, a student should be able to define and explain what is digital divide 
Duration: 40mins 
Week: 3 
Teaching Method/Strategy: Method 
Entry Behaviour (How you plan to start your Class): 
 
TYPES OF DATA MODELLING  

 

Flat Model: The flat Model (or Table) model consists of a single, two-dimensional array of data elements, where all 

members of a given column are assumed to be similar in values, and all member of row are assumed to be related to one 

another.  

 
Hierarchical model: 

In a hierarchical database, data is organized into an upside-down tree-like structure, implying a single upward link in each 

record to describe the nesting, and a sort field to keep the records in a particular order in each same-level list. Hierarchical 

structures were widely used in the early mainframe database management systems. 
 
Network Model: This model organizes data using two fundamental construct, called records and sets. Records contain 

fields, and sets define one-to-many relationships between records: one owner, many members. 
 
Relational Model  

The relational model or relational data base model is based on first-order predicate logic. Its core idea is to describe a 

database as a collection of predicates over a finite set of predicate variables, describing constraints on the possible values 

and combinations of values. 
 
Object-Relational Model  

The object relational model is similar to relational database model, but objects, classes and inheritance are directly 

supported in database schemas and in the query language. An object-relational database can be said to provide a middle 

ground between relational databases and object-oriented databases (OODBMS) 
 
Star Schema  

The star schema is the simplest style of data warehouse schema. The star schema consists of a few “fact table” (possibly 

only one, justifying the name) referencing any number of dimension tables”. The star schema is considered an important 

special case of the snowflake schema. 
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4. DATA MODEL III 

Objective: By the end of this class, a student should be able to define old and new economy 
Duration: 40mins 
Week: 4 
Teaching Method/Strategy: Method 
Entry Behaviour (How you plan to start your Class): 
 
Database packages are used to design a database in a computer. Example of a common database package is Microsoft 

Access. MS Access is a Relational Database Management System used to create and modify databases.  

 

ORGANIZATION OF DATABASE USING MS ACCESS  

To create a database on the computer with MS Access  

Load MS Access: do the following; 
Click on the Start Menu  

Point to All program  

Point to Microsoft Office  

Click on Microsoft office Access  

 

Creating Database  

From the displayed window, click on blank database.  

By the right hand side of the windows, where the arrow is pointing in the picture-screen above, click inside the file name 

text box and type the desired database name.  

Click on Create command button. 

A database with the filename given will be created  

 

Files are created as tables in the database  

Creating a file  

Click on Create menu and select Table  

At all Tables tab, right click on any of the table.  

Select design View  

 

In the Save As dialog box, type a desired table name (e.g. Student Table) in the Table Name text box and click ok.  

Tables in database on a computer are composed of rows and columns. A table in MS Access is organized into rows and 

columns like the picture screen shown below.  

 

A row contains records.  

A column usually represents a field in a database table.  

It contains specify the type of information.  

 

 
Create Fields with Data Types  

Fields are assigned field names relevant to the information they keep. Field names are assigned data types which 

determine the kind of data they accept as input. For example in MS Access table above, Surname are alphabetic, the fields 

will not accept numeric (numbers) inputs 10 or 500 as surname. To set data type for field in MS Access, follow the steps 

below; 

 
After creating the table in design view under the field name tab, then type the field name and under the data type tab next 

to the field name, click the drop down menu and select AutoNumber as shown below.  
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For example, using the above picture screen, the field name ID Number will be assigned Number data type since the ID 

Numbers will be numeric. In the same way, TEXT data type will be assigned to Surname and First name.  

 

Unique Identifier  

A table contains a unique identifier i.e. a KEY. In MS Access, a default primary key is usually specified for the first field. 

To set another field of your choice as primary key, right click on the first cell and select Primary Key.  

Note: The symbol of a key should appear beside the field, after setting that field as a unique identifier. If it does not 

appear repeat previous steps.  

 

Creating Database  

Generally, creating database using any DBMS entails the following basic steps:  

 
Define the Database Structure  

The database structure specifies the type of database organization that should be used. If the relational form is selected, 

the database structure will include RDBMS, structure of table, number of rows, number of columns, the key, and 

relationship of the database etc.  

 

Specify Field Type  

When a database is being created, all fields are set to accept a particular type of input by specifying a field type. A field 

type is also known as a Data type. The essence of a data type is to prevent a wrong input from being stored in a database 

(i.e. database integrity). Usually the name of a data type varies with DBMS but portrays a general meaning. These 

include;  

 

Alpha numeric/ text field: Fields that accepts both numbers and text e.g. ASP2548.  

 

Numeric Fields: Fields that accepts numbers in two forms: Real number i.e. decimal numbers e.g. 8.15, 9.1 and integers, 

whole numbers e.g. 125, 80 etc.  

 

Date Fields: They store data in date format e.g. 11-04-2009  

Boolean fields: The data accepted by these fields are either Yes/No or True/False.  

 

Memo: Long text. Use for long pieces of text. Such as notes and long description. Can store up to 64,000 characters.  

Currency: Use for currency.  

 

AutoNumber: Unique sequential numbers or random number automatically inserted when you create a record. Use to 

create primary key.  

 

Hyperlink: Use to store hyperlink  

 

Attachment: use to store attachments e.g files, images etc.  

 

OLE Object: Use to attach an OLE object such as word document, Spreadsheet, or Powerpoint Presentation  

 

Input Data 
After the field names and their data types have been specified, then records are stored in the database by specifying the 

appropriate input. In MS Access, to input a data:  
Double click on the Student Table at the left hand pane of MS Access windows  

Enter the data beneath the field names and click on the next cell to populate data.  

 

To keep database updated, data inputted into the database must be saved regularly. Keyboard command CTRL + S is 

used. Alternatively, you click on the Office button and save 
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BASIC OPERATION  

The basic operations to be considered are:  

Searching  

Sorting  

Modifying  

Generate report  

 

Searching  

On the Tools Menu, click Options  

Click the Edit/Find tab  

Under Default find/replace behave, do one of the following:  

Select Fast Search to search the current field and match the whole field.  

Select General search to search all fields and match any part of the field.  

Select Start of Field Search to search the current field and match the beginning characters of field.  

DBMS have certain command for saving a database. For example in MS Access, select the save option on the MS Access 

window to save. 

 
Sorting  

To sort records in form view or in datasheet view, follow these steps:  

Start MS Access, and then open the database that you are working with.  

Open the table or the form whose data you want to view.  

Click the field that you want to use for sorting records. To sort records in sub-form, click the field that you want to sort. 

To sort records in a sub-datasheet, display the sub-datasheet by clicking expand indicator, and then click the field that you 

want to sort.  

On the records menu, point to sort, and then click Sort Ascending or Sort Descending. NOTE: In a form, you can only sort 

on only one field at a time.  

O. P. Q.  

 

Sorting with sub-datasheet  

In datasheet view, when you sort the sub-datasheet for one record, MS Access sorts all the sub-datasheets at that level. In 

a datasheet or sub-datasheet, you can select two or more adjacent columns at the same time, and then sort them. Access 

sorts records starting with the leftmost selected column. When you save the form or datasheet, Access saves the sort order.  

Sorting Records on a Report  

Start MS Access, and then open the database that you are working with.  

Open the report in Design View.  

On the View menu, click “Sorting and Grouping” to display the sorting and Grouping dialog box.  

In the first row of the Field/Expression column, select a field name or type an expression. NOTE: When you fill in the 

Field/Expression column, MS Access sets the sort order to Ascending.  

You can sort up to10 fields or expression in a report. To sort your report on more than one field, add another field or 

expression to the Field/Expression column. The field or expression in the first row is the first sorting level. The second 

row is the second sorting level, and so on.  

 

 

 

 

 

 

 

 

 

 



 
The Breeder’s Guide 
Mathematics 

 

 

 
Modifying Data  

How to Add or edit Data in a Datasheet (Table or Query) or in a Form  

 

1. Open a table or a query in datasheet View or a form in Form View.  

2. Do one of the following:  

3. In MS Office Access 2003 or in earlier versions of Access, to add a new record, point to Go to on the Edit menu, 

and then click New Record. Type the data, and then press TAB to go to the next field. At the end of the record, 

press TAB to go to the next record.  

4. In MS Office Access 2007, to add a new record, click the Home tab, and then click New in the Records group.  

5. To edit data within a field, click in the field that you want to edit, and then type the data.  

6. To replace the entire value, move the mouse pointer to the leftmost part of the field until the pointer changes into 

the plus pointer, and then click. Type the data.  
  

NOTE: To correct a typing mistake, press BACKSPACE. To cancel your changes both in current field and in the entire 

record, press ESC.  

 

How to save a record in a Datasheet or in a Form  

 

NOTE: MS Access automatically saves the record that you are adding or editing as soon as you move to a different 

record or close the form or table that you are working on.  

 

Explicitly, to save the data in a record while you are editing, In Access2003 or earlier versions,  

Click Save Record on the Records menu.  

In Access 2007, Click the HOME tab, and then click Save in the Records group. 

 

 
How to Delete a Record in a Datasheet or in a Form 

 

1. Open a table or a query in Datasheet view or open a form in Form View.  

2. Click the record that you want to delete.  

3. In Access 2003 or in earlier versions, Click Delete Record on the Edit menu. In 2007, click the Home tab, and 

then Click Delete Record in the Delete list in the Records group.  

 

 
Generating reports  

1. AutoReport  

2. Open the database window (F11) and click on the Report tab.  

3. Click New. A dialog box appears.  

4. Choose between Columnar and Tabular.  

5. Select the table or query that you want to use for you report.  

6. Click OK.  

7. Create Your Own Report  

8. Repeat the first two steps above.  

9. When the dialog box appears, click Design View.  

10. Select the table or query that you intend to use.  

11. Click OK.  

12. Report Wizard  

13. Repeat the first two steps above.  

14. Click the wizard that you want to use for your report.  

15. Select the table or query that you want to use for your report.  
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16. Click OK.  

17. Follow the instructions that the wizard provides.  
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5&6 DATA MODEL 

Objective: By the end of this class, a student should be able to state the uses of database 
Duration: 40mins 
Week: 5 
Teaching Method/Strategy: Method 
Entry Behaviour (How you plan to start your Class): 
 

Editing data type in fields  
When creating tables, you should define the data types of the table to the most closely match the type of data that will be 

entered in the field.  

To edit data type in Data sheet view. 
 

 

Click the field you wish to define.  

Click the Datasheet tab on the Ribbon.  

Click the down arrow next to Data type.  

Choose the type of data that will be entered into the field.  

 

To edit the data of the format,  

Click the field you wish to define.  

Click the datasheet tab on the ribbon.  

Click the down arrow next to the format.  

 

To edit Data type in the design View,  

Click design View.  

Click the field name you wish to define or create (for new field).  

Click the Data Type.  

Choose the appropriate Data Type.  

Format the field in the Field Properties dialog Box.  

 

To Delete a Table,  

Open the desired database by clicking the Microsoft office button and clicking Open.  

Right click on a table and choose Delete.  

 

To Rename a table,  

Open the desired database by clicking the Microsoft office button and clicking Open.  

Right click on a table and choose Delete.  

Type in the new name.  
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Creating Forms  

Forms allows you to enter, edit or display data. They are based on tables. With forms, you can choose the format and 

arrangement the fields will take or will be displayed.  

 

To create a form  

Open the navigation pane  

Click the table or query on which you want to base your form  

Activate the create tab  

Click form in the forms group  

 

After you create a form, you can save it. You can also open a saved form at any time.  

Click the save button on the Quick Access toolbar.  

Type the name you want to give the form.  

Click OK. You can access the form by clicking the navigation pane.  

 

Form Wizard  

You can create forms with the help of a form wizard  

On the create tab, click the more forms down arrow.  

Click Form Wizard  

Choose the Table/ Queries that you wish to have on the form  

Choose the field you wish to have on the forms  

Click Next  

Choose the layout for the form  

Click Next  

Choose Style  

Click next  

Create a title for the form  

Choose whether you want to open the form to view it or modify the form’s design  

Click finish  

 

 
Creating Queries  

A query allows you to select and filter data from multiple tables. Queries can be saved and utilized as often as you need 

them.  

 

Creating using Query Wizard  

1. The Query Wizard walks you through the steps to set up a query. To run a query using the query wizard  

2. Click the create tab  

3. Click the query Wizard button under other group  

4. Choose the type of query you wish to run  

5. Click OK  

 

To choose the field you wish to include from each table  

1. To select fields from different tables, click the Tables/Queries down arrow  

2. Click OK  

 

To insert picture of query wizard  

1. Type in a title for the query  

2. Click Finish  

3. The query will be displayed  
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CREATING REPORT  

Reports organize and summarize data for viewing online or for printing. A detail report displays all of the selected 

records. Reports are a means to view and analyse large amount of data. You can use the report wizard or create a custom 

report that meets your specific need.  

 

1. Click the Blank report button on the Create Tab  

2. Click the Add Existing Fields button  

3. From the field list, click and drag the fields to the report  

 

Creating using Report Wizard  

1. On the Create tab, click ,the report Wizard button  

2. Choose the Tables/Queries that you wish to have on the form  
3. Choose the field you wish to have on the forms  

4. Click Next  

5. Choose the sort order for your report  

6. Choose the layout for the form  

7. Click Next  

8. Choose a style  

9. Click Next  

10. Create a title  

11. Choose whether you want to o[pen the form to view it or modify the form’s design  

12. Click Finish  
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8&9. DATA MODEL IV 

Objective: By the end of this class, a student should be able to define and state the uses and practical 
application of spreadsheet. 
Duration: 45mins 
Week: 6 
Teaching Method/Strategy: Method 
Entry Behaviour (How you plan to start your Class): 
 
Significance of Data Model  

Data model is a great communication tool because it facilitates interaction and communication between the designers, 

programmers and end users. In essence it does not allow one party’s bias towards a certain view of a data (whether they 

consider to be most important) to take hold.  

 

A well-developed data model can even foster improved understanding of the organization for which the database design is 

developed.  

Data model help in structuring and organizing data. These data structure are then typically implemented in a database 

management system which is used mostly by organization for decision making.  

 

In addition to defining and organizing the data, data modelling will impose (implicitly or explicitly) constraints or 

limitation on the data placed within the structure  

 

Standard Data Model 

A standard data model or industry standard model (ISDM) is a data model that is widely applied in some industry, and 

shared amongst competitors to some degree. They are often defined by standard bodies, database vendors or operating 

system vendors.  

The most effective standard model have developed in the banking, insurance, pharmaceutical and automotive industries, 

to reflect the stringent standards applied to customer information gathering, customer privacy, customer safety, or just in 

time manufacturing.  

 

They enable easier and faster information sharing because heterogeneous organizations have a standard vocabulary and 

pre-negotiated semantics, format, and quality standards for exchanged data.  

 

Normalisation 
Normalization is the process of effectively organizing data in a database.  

 

The primary purpose of normalization is to allow update, insert and delete operations to be performed on a single database 

table and propagated throughout the database by means of the defined relationship.  

 

There are two goals of the normalization process:  

1. Eliminating redundant data (for example storing the same data in more than one table)  

2. Ensuring data dependencies make sense (only storing related data in a table)  
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NORMAL FORM  

The normal form (NF) of relational database theory provide critical for determining a table’s degree of vulnerability to 

logical inconsistencies and anomalies. The higher the normal form applicable to a table, the less vulnerable it is. Each 

table has a “Highest Normal Form”(HNF): by definition, a table always meets the requirements of its HNF and all normal 

forms lower than its HNF; also by definition, a table fails to meet the requirement of any normal form higher than its 

HNF.  

Normal form theory deal with how to reduce the amount of redundancy of data within a given table. Each normal form 

represents a level. To satisfy each the requirements for certain level, the requirements for the previous level must be met. 

To reach the optimal normal form for the tables within a database, the creator starts with a large list of all the data that is 

to be held in the database, and then works through the normal forms until he can no longer break the data down into 

smaller table. 

 

Types of Normal Form 
 

First Normal Form (1NF) 

First Normal Form (1NF) says that all column values must be atomic. 1NF 

dictates that, for every row by column position in a given table, there exist 

only one value, not an array or list of values i.e in 1NF, the following rules 

are observed; 

1. Eliminating repeating information 

1. Create separate tables for related data. 

 

Second Normal Form (2NF) 
The second normal form (2NF) further addresses the concept of 

removing duplicate data. The rule for the second normal form is; 

1. Remove subsets of data that apply to multiple rows of a table and 

place them in separate table. 

1. Create relationships between these new tables and their 

predecessors through the use of foreign keys. 

 
NOTE: The 2NF attempts to reduce the amount of redundant data in a table by extracting it, placing it in new table(s) and 

creating relationships between those tables.  

 

Third Normal Form (3NF) 

 

There are two basic requirements for a database to be in Third Normal Form:  

The requirements of both 1NF and 2NF must have been met.  

Remove columns that are not fully dependent upon the primary key.  

 

 

The Fourth Normal Form (4NF) and Fifth Normal Form (5NF)  

The fourth and the fifth normal form are beyond the scope of this syllabus.  

Note: Both the fourth and the fifth normal form still follows the goal of normalization process, which are;  

eliminating redundant data.  

ensuring data dependencies make sense.  
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A key is an attribute or field that can be used to identify a record in a database table or file.  

The primary Key is a unique attribute that can be used to identify a record in a database table. For Example, in the 

student database table above, the attribute that is unique to identify each record is the Student- ID or RegNo. 

 

 
CONCEPTS OF FOREIGN KEY  

A foreign key is a field in a relational table that matches a candidate key of another table. A foreign key (FK) is a column 

or combination of columns that is used to establish and enforce a link between the data in two tables. You can create a 

foreign key by defining a FOREIGN KEY constraint when you create or modify a table. The foreign key can be used to 

cross-reference table. The foreign key identifies a column or set of columns in one (referencing or child) table that refers 

to a column or set of column in another (referenced or parent) table. The columns in the child table must reference the 

columns of the primary key or other super key in the parent table. 

 
EXPLAIN THE DETERMINATION OF NORMAL FORM  

Normalization is a technique for producing a set of suitable relations that support the data requirements of an enterprise. 

Characteristics of a suitable set of relations include: 

1. The minimal number of attributes necessary to support the data 

requirements of the enterprise 

1. Attributes with a close logical relationship are found in the same 
relation. 

1. Minimal redundancy with each attribute represented only 

once with the important exception of attributes that form all 

or part of foreign keys. 
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10&11. DATA MODEL V 

ENTITY – RELATIONSHIP MODELS  

Entity-Relationship is a graphical representation of entities and their relationships to each other. Entity relationship 

diagrams (ERDs) illustrate the logical structure of database. Diagrams created to design these entities and relationships are 

called entity-relationship diagrams or ER diagram.  

 

Uses of Entity Relationship Diagram  

The Entity-Relationship Diagram is used to identify the data that must be captured, stored and retrieved in order to 

support the business.  

The Entity-Relationship Diagram is also used to identify the data required to derive and generate report on the 

performance measures that an organization should be monitoring.  

 

Components of Entity-Relationship  

Entity- Relationship diagrams have three different components;  

Entities  

Attributes  

Relationships  

 

Entities: Entities are objects or concepts within the data model. Each entity is represented by a box with in the ERD. An 

entity might be considered a container that holds all of the instances of a particular thing in a system.  

 

Attributes: a key attribute is the unique, distinguishing characteristics of the entity. Primary key is always the attribute of  

ER. Entities are further described by their attributes (sometimes called data element). These are the smallest units of data 

that can be described in a meaningful manner.  

 

Relationship: A relationship is an association among the instances of one or more entity types that is of interest to the 

organization. A relationship is the association between entities or entity occurrence. 

 
Cardinality: The cardinality defines the relationship between the entities in terms of numbers. 

 
Types of cardinality relationship  

There are potentially three types of relationship which can exist between different entities;  

1. One-to-One Relationship  

2. One-to-Many Relationship  

3. Many-to-Many Relationship  
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